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Chapter 1
ODB++ Viewer

You can use ODB++ Viewer to examine the step of a product model that is stored in an ODB++Design
directory structure.

Opening a Product Model Step
Filtering the Product Model List
Importing ODB++Design Data
ODB++ Viewer Window

Viewing the Step and Repeat Table
Troubleshooting
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Opening a Product Model Step

Opening a Product Model Step

You can open a step in an ODB++ directory structure that has been compressed into any of these file
types: tgz, gz, Z, tar, or zip. You can view the graphic of the step and information about each layer of the
step.

When you first open ODB++ Viewer, you choose the step you want to view. Subsequently, you can
choose a different step to view, from within ODB++ Viewer.

The procedure for opening a product model step depends on whether you are working in direct mode or
in database mode.

« Direct mode — If your product models do not reside in a database, you can import each product
model into the ODB++ Viewer Product Model List and open a product model step from the list.

- Database mode — Some Valor applications maintain a database where ODB++ product models
are cataloged. User access to these product models is managed by the application. If your
product models reside in such a database, ODB++ Viewer runs in database mode, and the
Product Model List dialog box lists the product models in the database. You can open a product
model that is cataloged in the database, or you can import a product model from an ODB++
directory structure or compressed file into the database, and then open it in ODB++ Viewer.

When ODB++ Viewer opens in database mode, it requires a username and password with rights
to access the database. At some sites, the Valor application that maintains the database has
been set up to bypass the login screen and to provide a valid username and password silently.

Opening the Step in Direct Mode
Opening the Step in Database Mode

Opening the Step in Direct Mode

You can open a step in a product model that resides in an ODB++ directory structure, or in an ODB++
product model that has been compressed to one of these file types: tgz, gz, Z, tar, or zip.

Procedure
1. Open the Product Model List dialog box.

If you want to... Do the following:

Open ODB++ Viewer Open ODB++ Viewer in one of the following ways:

and open the step » From the desktop icon

6 ODB++ Viewer User Guide




ODB++ Viewer

Opening the Step in Direct Mode

If you want to... Do the following:

* From the Windows Start menu

OB ODB + + Viewer

App

ODB++ Viewer

Open a different step in | In ODB++ Viewer, choose File > Open Job.

The Product Model List dialog box opens.

B | Product Model List

s

Product Model: | =

Model Mame

+- aspen_new
unicam_pdw
testcased
Jjob_pdif

+- demo_design
carcube_new

Remove

Import |

Cpen

The list displays the locations of the ODB++ product models that have recently been imported into

ODB++ Viewer.

You can expand a product model node to list the steps of the product model.

By default, the Product Model List appears as a simple list of product models. Also available is the
“details” mode, which lists the product model names and full paths. You can use the toggle button

ﬂ to switch between the modes.

B | Product Model List

Product Model: | =

Full Path

aspen+1
unicam_pdw
testcasef
job_pdif
+- demo_design
carcube_new

Remove

_iCy/MentorGraphics/Valor/vNPI_DIR/fw/jobs/aspen_new

C:/MentorGraphics/Valor/vMPI_DIRfw/jobs/unicam_pdw
Ci/MentorGraphics/Valor/vMNPI_DIRfw/jobs/testcaset
C:/MentorGraphics/Valor/vMPI_DIRfw/jobs/job_pdif
C:/MentorGraphics/Valor/ vMPI_DIRfw/jobs/demo_design
C:/MentorGraphics/Valor/vMPI_DIRfw/jobs/carcube_new

Import

Cpen
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ODB++ Viewer

Opening the Step in Database Mode

To restrict the Product Model List, type a string in the Product Model field.

To import a product model into the Product Model List, click Import.

To remove a product model location from the Product Model List, select it and click Remove.

2. In the Product Model List dialog box, double-click the product model or step you want to open, or
select the step and click Open.

Related Topics

Filtering the Product Model List

Importing ODB++Design Data

Opening the Step in Database Mode

If you are working in database mode, you can open a product model that resides in an ODB++ database.
You can import a product model from disk into the database. Product models can be imported from an
ODB++ directory structure, or from one of these compressed file types: tgz, gz, Z, tar, or zip.

Procedure

1. Open the Product Model List dialog box.

If you want to...

Do the following:

Open ODB++ Viewer
and open the step

Open ODB++ Viewer in one of the following ways:
* From the desktop icon

* From the Windows Start menu

OB ODB+ + Viewer

App

When ODB++ Viewer opens in database mode, it requires a username

and password with rights to access the database. At some sites, the Valor
application that maintains the database has been set up to bypass the login
screen and to provide a valid username and password silently.

Open a different step in
ODB++ Viewer

In ODB++ Viewer, choose File > Open Job.

The Product Model List dialog box lists the product models in the database that was specified

during installation.

ODB++ Viewer User Guide
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Opening the Step in Database Mode

*

® | Product Model List

Product Model: | * f

Model Mame

+- aspen_new
unicam_pdw
testcased
job_pdif

+- demo_design
carcube_new

Import | Open |

You can expand a product model node to list the steps of the product model.

By default, the Product Model List appears as a simple list of product models. Also available is the
“details” mode, which lists the product model names and full paths. You can use the toggle button

ﬂ to switch between the modes.

B Product Model List *

Product Model: | =

Muodel Mame Full Path
—iaspen_new i C/MentorGraphics/Valor/wNPI_DIR/fw/jobs/aspen_new
aspen
panel
aspen+1
unicam_pdw C:/MentorGraphics/Valor/vMNPI_DIRfw/jobs/unicam_pdw
testcased C/MentorGraphics/Valor/vNPI_DIR/fw/jobs/testcaset
job_pdif C:/MentorGraphics/Valor/vMPI_DIRfw/jobs/job_pdif
+ dermo_design C:/MentorGraphics/Valor/vMNPI_DIR/fw/jobs/demo_design
carcube_new C:/MentorGraphics/Valor/vMPI_DIRfw/jobs/carcube_new

Import | Cpen

To restrict the Product Model List, type a string in the Product Model field.

To import a product model into the database, click Import.

2. In the Product Model List dialog box, double-click the product model or step you want to open, or
select the step and click Open.

Related Topics
Filtering the Product Model List

Importing ODB++Design Data
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Filtering the Product Model List

Filtering the Product Model List

You can restrict the Product Model List to show only product models whose name contains a constant
string, or intervening characters at specific locations.

Prerequisites

You have opened the Product Model List dialog box as described in “Opening the Step in Direct Mode” on
page 6 or “Opening the Step in Database Mode” on page 8.

Procedure

Use the appropriate filtering option:

If you want to...

Do this:

List product models
containing a constant
string

Enter the constant string in the filter.

For example, entering the string demo lists product models whose names
include the string demo anywhere in the name.

m Product Meodel List

Product Model; | demo

1

Model Mame

+- demo_design
demo_design+1
demoenstration
panel_demo

Import

Open

List product models
whose names may
contain intervening
characters at specific
locations

Enter a string containing asterisks (*) to indicate where there may be

intervening characters.

For example, entering the string demo*1 lists product models with names
including the string demo, and then any intervening characters or no
intervening characters, and a one, anywhere in the name.

10
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ODB++ Viewer
Importing ODB++Design Data

If you want to... Do this:
E2 Product Model List >
Product Madel: ||:Iem|:|‘1 ﬂ
Model Mame
demo

demo_design+1
demo_design
veure_demol

Import Open

List product models Enter a string containing question marks (?) to indicate where there must be
whose names contain | intervening characters.
intervening characters

at specific locations For example, entering the string ?demo?1 lists product models with names

including the string demo, and then some intervening characters, and a one,
where the string demo is not at the beginning of the product model name.

2 Product Model List et
Product Model: | ?demo?1 B
Model Mame

+- apd_dermno+1
create_panel_demo+1

Import Open

Importing ODB++Design Data

You can import an ODB++Design product model residing in an ODB++ directory structure or compressed
to one of the following file types: tgz, gz, Z, tar, zip.
Prerequisites

You have opened the Product Model List dialog box as described in “Opening a Product Model Step” on
page 6.

ODB++ Viewer User Guide 11



ODB++ Viewer
Importing ODB++Design Data

Procedure

1. In the Product Model List dialog box, click Import.

2. In the Open File or Select Directory with “Accept Dir” dialog box, use one of these options:

To import a product model that resides in an ODB++ directory structure, browse to the directory

containing the ODB++ structure and click Accept Dir.

ona

Ck] Open File or Select Directory with "Accept Dir

? >

Look in: I C:YjobsYjobs j G (=} 0 E] E
‘ My Computer Mame /| Size Type Date Modified il
O Fil.der 1/15/2018 1:45:10 PM
flows Fil..der 1/15/2078 1:45:10 PM
fonts Fil..der 5/7/20191:27:26 PM
forms Fil..der 1/15/2018 1:45:10 PM
input Fil..der 3/7/20191:27:26 PM
matrix Fil..der 3/7/2019 1:27:28 PM
misc Fil..der 3/7/2019 1:27:28 PM —
output Fil..der 1/13/2018 1:43:12 PM
stackups Fil..der 1/15/2018 1:45:12 PM
steps Fil..der 5/7/2018 1:27m:28 PM
curmnhinle Fil der 1152008 1-A5.20 DRA
. e

File name: I

Open

Files of type: IAII QDE++ input files (*.tgz *.0z *.Z *.tar *.zip)

;I Cancel

Selected Directory: IC:,.’jnbs,.’jan

Accept Dir |

V.

12
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ODB++ Viewer
Importing ODB++Design Data

» To import a product model that is compressed to a file, browse to the directory containing the
file, select the file, and click Open.

ona

L] Open File or Select Directory with "Accept Dir" ? >
Look in: I C:Yjobs j G () 0 @ E
‘ My Computer Marne /| Size Type Date Maodified
Jobb Fil..der 3/7/201% 1:27:44 PM

B demo_assytgz 741 KB tgz File 7/16/2018 8:16:02 P

| | 2

File name: Idemn_assy.tgz Cpen
Files of type: IAJI CDB++ input files (*.tgz *.gz *.Z *.tar *.zip) ;l Cancel
Selected Directory: IC:fjubs Accept Dir |

z

Results
The newly imported product model is added to the top of the Product Model List.

ODB++ Viewer User Guide 13
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ODB++ Viewer Window

ODB++ Viewer Window

You use the ODB++ Viewer to view the graphic of the product model step, and information about the

layers of the step.

Figure 1. ODB++ Viewer Window

File Actions View Help

j| ODB++ Layer List | -
SOOI

sst

spt

sigt

- sigd @

sig3

sigd
pga

sig?

sigh J

m ODEB++ Viewer [Job: demo_design; Step: rev_a]

=PpAMeTALO|w t2DRMU-#[COD O TN

Signal sigZ, 5753 feasures, EDR Layers = "signal 2", "signal™, "VIA"

, ¥ = -0.5011604"

Objects

Table 1. ODB++ Viewer Window - Panes

Pane

Description

ODB++ Layer List

= ODB++ La}rerList| i‘
Jooooooonon.. =
spt

sst
s -

Used to choose layers to be displayed in the board
viewer.

-
The color of the cell in the layer column (=) indicates
the color in which the layer is displayed.

You can use the feature histogram or the component
histogram of a layer to highlight groups of entities in the
graphic area.

See “Using the Features Histogram to Select or Highlight
Features” and “Using the Components Histogram to

14
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ODB++ Viewer
ODB++ Viewer Window

Table 1. ODB++ Viewer Window - Panes (continued)

Pane

Description

Select or Highlight Components” in Getting Started With
ODB++Design.

Board Viewer pane

Bl = 3.74854537", Y = 2_.4%522438"

Displays the graphic representation of the chosen layers.

The X and Y coordinates of the current mouse pointer
position are displayed below the graphic.

Component Filter

E70 * PinMame: 1 -
@ RefDes CPM IPM
P Package vPackage |§| |§|

To display this pane, choose View > Component Filter or
click the Component Filter tool (fu').

See Using the Component Filter Pane to Find
Components” in Getting Started With ODB++Design.

Overview pane

Use the Zoom area tool (@) to drag a rectangle in this
pane, or in the board viewer, to zoom to that area in the
board viewer.

Data bar
Highlighted: 11%; EBOT f#41 TP1lO%
Part: 7% Pkg: TP20 BOT 1 Pins

®=3.1l62 T=-2_377
L=0_.07E5 W=0.075 H=0 Rot=0.0 T= P=0

The data bar at the bottom of the window displays
information about highlighted features or components.

When multiple features or components are highlighted

by double-click, the number of highlighted features or
components is prefixed to the details of the first feature or
component.

Table 2. ODB++ Viewer Window - File Menu Options

Tool File Menu Option Description

- Open Job Opens the Product Model List dialog box so you can
open a product model whose steps you want to view.

- Open Step Lists the steps of the current product model, so you
can open the step you want to view. This option is
unavailable if the product model has only one step.

- Exit Exit the ODB++ Viewer.

ODB++ Viewer User Guide
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ODB++ Viewer Window

Table 3. ODB++ Viewer Window - Actions Menu Options

Tool Actions Menu Option | Description
- View Orientation Open the “View Orientation” dialog box that enables
you to rotate, mirror, or flip the board view.
w0 Highlight Click the tool and click a feature to be highlighted in
% Highlight-2 the colors set for Highlighted and Highlighted-2.
A symbol in the Color of features for each layer
column of the ODB++ Layer List indicates whether
one or two features are highlighted on the layer.
% ODB++ Layer List
OO
P Highlight NET Open the Highlight CAD Nets dialog box in which
you can use two tabs to highlight CAD nets in two
different colors.
Choose a tab and select a CAD net to be highlighted,
or press Shift or Ctrl to select multiple nets.
The legend lists the names of the selected nets
separated by semi-colons (;). The color in which the
selected nets are displayed is indicated.
2 Highlight CAD Nets ¥
CAD Met1  CAD Net2
MET: .
£1N106 i‘
£1N10& 29
£1H107
£1N107_29
£1N104
£1H108 29
£1H1133 j
[v CAD Met 1: £1N1644
[w CAD Net 2: £1N107
[+ Show on viewed layers only
To view the features of the highlighted net on the
currently displayed layers only, select the option
“Show on viewed layers only”.
o Clear Highlighted Clear highlighting applied using Highlight or
Highlight-2.
16 ODB++ Viewer User Guide
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ODB++ Viewer Window

Table 3. ODB++ Viewer Window - Actions Menu Options (continued)

Tool Actions Menu Option | Description

T Measure Between Opens a sub-menu where you can choose whether

R Points to measure between points, features, nets, or

d Measure Between annular rings.

4 Features See “Measuring Distances” in Getting Started With
ODB++Design.

Measure Between

Ei Nets

Measure Annular
Rings

H# Snap Open the Snap dialog box in which you can define
shap and grid options.

Table 4. ODB++ Viewer Window - View Menu Options

Tool View Menu Option Description

- Step & Repeat Table See “Viewing the Step and Repeat Table” on
page 21.

= Matrix Opens the “Matrix” window displaying the layer
construction, layer types and subtypes, polarity, drill
intersection with board layers (for drilled via holes),
and sub-panel nesting.

2O Zoom In, Zoom Out Zoom in or zoom out.

[ Zoom Area Invoke the zoom area tool for drawing a zoom
rectangle in the board viewer or overview pane.

B Zoom PopView Display a magnified view of a section of the board.
You can open more than one popview window at the
same time. See “Zooming and Panning” in Getting
Started With ODB++Design.

@ Zoom Home Zoom to a view that fits the board in the graphic area.

a2 Previous Zoom Returns to the zoom factor that was in effect before
the most recent zoom action.

H Pan XY Open the Pan XY dialog box.

2 Pan xy — O >

X - H.EdElEEE " ¥ : |3.051&B11 "

Goto |

ODB++ Viewer User Guide
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Table 4. ODB++ Viewer Window - View Menu Options (continued)

Tool View Menu Option Description
Type the X and Y coordinates to be brought to the
center of the graphic area and click Goto.

Qo b Pan Left, Pan Right, Pan left, right, up, or down.

Pan Up, Pan Down .
(shortcuts: keyboard arrow keys).

G View Properties Open the “Component Information” or “Feature
Information” dialog box to view detailed information
about the selected item.

So Component Filter Open the component filter pane. See “Using the
Component Filter Pane to Find Components” in
Getting Started With ODB++Design.

a Color Settings Open the “Colors” dialog box that enables you to set
colors for displaying items in the graphic area.

- Component Options Open the “Component Display Options” dialog box
that enables you to configure some aspects of how
components are displayed in component layers.

- Show Populated Toggle between showing all components and

Components Only / showing only populated components.
Show All Components

- Control Open the “Control” dialog box that enables you to

control the display of data in the graphic area.
Table 5. ODB++ Viewer Window - Help Menu Options

Tool View Menu Option Description

- View Help Opens documentation for the ODB++ Viewer.
(shortcut: F1)

- About Displays ODB++ Viewer version and system
information.

Table 6. ODB++ Viewer Window - Board Viewer Right-Click Menu Options
Option Description
Zoom area Invokes the zoom area tool so you can drag a zoom rectangle in the board
viewer pane or overview pane.
Equivalent to clicking the Zoom Area (@) tool.
Popview Display a magnified view of a section of the board. You can open more than
one popview window at the same time. See “Zooming and Panning” in Getting
Started With ODB++Design.
18 ODB++ Viewer User Guide
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Table 6. ODB++ Viewer Window - Board Viewer Right-Click Menu Options (continued)

Option Description
Measure Invokes the measure tool so you can measure the distance between two
points.
Equivalent to clicking the Measure ( 4 ) tool.
See “Measuring Distances” in Getting Started With ODB++Design.
Highlight Invokes the highlight tool so you can highlight a feature or component.

Equivalent to clicking the Highlight a feature or a component (%) tool.

Clear highlighted

Clears all highlighted features and components.

Equivalent to clicking the Clear Highlighted ("‘;“) tool.

Toggle pile-up Overlapping features make it difficult to choose an individual feature from
selection among them. Pile-up selection mode provides a list of overlapping features
that are at the board location at which you clicked, from which you can choose
the feature you want.
J_I : Select All
TOP =545, REL
TOP =8da, R15
TOP #1715, XU1L
i
Table 7. ODB++ Viewer Window - Board Viewer Shortcuts
Shortcut Description
Ctrl+a Invokes the Zoom area tool for one actuation. After you have dragged a
rectangle in the board viewer pane or in the overview pane, the tool that was
previously in effect is in effect.
Ctrl+d Pan down with 90% overlap.
down arrow
Ctrl+e Click on the board graphic and press Ctrl+e to pan the board viewer pane to
center that point in the pane.
Ctrl+h Zooms to a view that fits the entire board in the graphic area.
Ctrl+Home
Ctrl+i Zooms in. Equivalent to clicking the Zoom In tool (c@ ﬁ/)
Page Up
Ctri+l Pan left with 90% overlap.

ODB++ Viewer User Guide
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ODB++ Viewer Window

Table 7. ODB++ Viewer Window - Board Viewer Shortcuts (continued)

Shift+down arrow

Shortcut Description

left arrow

Ctrl+m Toggles between a four layer display and more than four layers.
Ctrl+o Zooms out. Equivalent to clicking the Zoom Out tool (545 5—4)
Page Down

Ctrl+r Pan right with 90% overlap.

right arrow

Ctrl+Shift+d Pan down with 10% overlap.

Ctrl+Shift+
Shift+left arrow

Pan left with 10% overlap.

Shift+up arrow

Ctrl+Shift+r Pan right with 10% overlap.

Shift+right arrow

Ctrl+Shift+Space Returns to the zoomed display in memory after zooming other areas.
Ctrl+Shift+u Pan up with 10% overlap.

Ctrl+Space Copies the current zoomed display to memory.
Ctrl+u Pan up with 90% overlap.
up arrow
Ctrl+w Toggles the view of features among these modes:
full J , outline ""I" M, or width off
middle-click The middle button can be used for these pan and zoom functions:

 Center in Graphic Area — Middle-click a point in the graphic area. The
click point is panned to the center of the graphic area.

» Zoom Out — With the middle button, drag a diagonal up and to the right,
ending at the point you want in the center of the graphic area.

* Zoom In — With the middle button, drag a diagonal down and to the left,
ending at the point you want in the center of the graphic area.

20
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Viewing the Step and Repeat Table

Table 7. ODB++ Viewer Window - Board Viewer Shortcuts (continued)

Shortcut Description

» Zoom to Area — With the middle button, drag a diagonal down and to the
right, so that the start and end of the line you drag define a rectangular
area to which you want to zoom.

» Zoom Home — With the middle button, drag a diagonal up and to the
left. The view zooms so that the whole board is displayed centered in the
graphic area.

Shift+tHome Zooms to a view that fits the highlighted component in the board area.
Equivalent to clicking the Zoom Home tool (@).

Usage Notes

Click one or more layers in the ODB++ Layer List to display them in the board viewer.

To use the board viewer shortcuts, you must place the mouse pointer in the board viewer pane.

» Click the Toggle Units tool ('-h-l) on the toolbar to toggle the measurement units displayed in the
X and Y coordinates under the board viewer, and for the Measure tool, between inches and mm.

Viewing the Step and Repeat Table

If your product model contains step and repeat data, you can view panelization information in the Step &
Repeat Table dialog box.

Procedure

1. Choose View > Step & Repeat Table.

9% Step & Repeat Table

Step Arichor Point Hx Ny Dx (" 1 Dy (" 1} Angle Flip
[.'LZ ][CI.DCIDDDD ,D.DDCIDDCI] 1 4 0.000000 0. 000000 270 W Nao 4
[pcb “D_UDDUDU ,D_DUDDUD] 1 4 O._oooooo 0. oooooo0 a0 W
[New step :”D.DDUDDD ,U_UDDUDD] 1 1 o_oooooo 0. oooooo a b Mo w
[ Close

2. View the panelization information in the table:

Column Description
Step Name of the step.
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Column Description

Anchor Point Anchor point of the step.

Nx, Ny Number of steps in the X and Y directions.

Dx, Dy Distance between steps in the X and Y directions, in the indicated units of
measure.

Angle Rotation angle for the step inside the panel.

Flip Indication of whether the step is flipped about the Y-axis.
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Troubleshooting

If the ODB++ Viewer does not run as expected, review the suggested troubleshooting topics.

Cannot Open ODB++Design Archive File on Windows 7
Entry Point Errors Due to Wrong DLL Usage

Cannot Open ODB++Design Archive File on
Windows 7

If you cannot open a fgz file in ODB++ Viewer, this is most likely caused by incorrectly set permissions
with the database. This problem can also affect your vendors and make the files unusable to them as
well.

Symptoms
When attempting to open a tgz file, Windows 7 displays this error message:

ERROR: gen_txt-6003-Unable to open file

Causes

Incorrect permission settings in Windows 7.

Solution

To correct the permission problems with the database, perform these steps:
1. In Windows Explorer, right-click the directory where your design resides and choose Properties.
2. Click the Security tab.
3. Click Edit.

4. Add Write privileges to the appropriate users. In this case, Everyone.

Note:
This procedure provides only a temporary fix for the tgz file you are attempting to open. As a long-
term solution, your IT department must ensure that permissions are set correctly for everyone.

Entry Point Errors Due to Wrong DLL Usage

After successful install of ODB++ Viewer, you may receive Entry Point Not Found errors when trying to
run the program.
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Symptoms

Examples of Entry Point Not Found error messages:

f The procedure entry point

@ Tend @ Qt@@YAAEAVQTextStream@ @AEAVZ @B Y could not be
located in the dynamic link library
CiMentorGraphics\Walor\ODB+ +_Viewer\odbviewer_cversiedininvidep
shwalor_gt_514Yib\Qt5XmlLdil.

-OIC |

f The procedure entry point

@ TtabletEvent@0Widget @ @MEAAXPEAVOTabletEvent @@ @Z could
not be located in the dynamic link ibrary
ChMentorGraphics\Walor\ODEB+ +_Viewerodbviewer_cvers edirymdlish,
QDBEViewerwingd.opt.Vsure.dil.

oK I

Causes

External QT DLLs are found in the C:\Windows\System32 location, which always has the highest PATH
priority. As a result, the wrong DLL files are loaded when the software is started.

Solution

Place the QT files supplied with the installation next to the main executable:

1. Copy all the files from:
..Jodbveiwer_<ver>/edir/nv/deps/valor_qt 514/lib
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Clipbosrd Organize Hew (4
L o odbviewer_ oasr edic » v ¢ deps » valor gt 514 » lib w D
* O MHame " Date medified
Coess i
% CSCeredil
P o ~,
o CtSGuidi
- g % QEsMutimedia,dil
meenks o 14 CtSMetwarkdii
s + 4 SPrintSuppant.dil
i CtSSug.dil
kg < CeSWidgets.di
& | i dil
amples
2. Paste the copied files to:
../odbveiwer_<ver>/get
Organize M Open
v Q0B== Viewer o odbviewsr o v edic » get w O Serrch get
~ [ Mame ' Date modified Type
£ imageformats TrE8/A020 1:48 P File folder
W] odbviewer.exe mpphcstion
o |4] ODBVEewenwinkd.opt GanLowLeel di Applecation et
8 [3 ctsConedn Applecation e
o I.E C5Gas.dil Application exh
|"‘| CtShduitimedia.dil £ Apphcation exh
| Ctshetworc.dil TR0 8:00 PM Apphcation ext
. -'E GtSPantSuppot.dl 121 /2020 800 P Application el
|5 CS5wg Tr1 /2020 8:00 P Application st
|4 ctSwidgets.dn TF2V 2020 200 P Application st
“\\ Gt end.dll TR0 800 P Applheation ext
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